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1. General 

1.1. Can you briefly explain the idea of how the BUYD Backup Software works? 

The Online Backup Suite consists of 3 main modules: 
 

1. The client software – Back Up Your Data Manger (BUYDM) 

2. The server software – Back Up Your Data Server (BUYDS) 

3. The replication server – Replication Server (BUYDR) 

 
BUYDM is a client application with a user-interface for easy backup configuration. It allows users to upload 
selected files to the Backup server and runs scheduled backup jBUYDS. It also allows users to create different 
backup sets for different backup purpose. Besides file backup, BUYDM can backup a list of applications such as MS 
Exchange, MS SQL, Oracle, MySQL, Lotus Domino, and much more. BUYDM supports Windows 2000, XP, 2003, 
Linux, Mac OS X, etc. 
 
BUYDS is a server application which store backup data from multiple BUYDM backup accounts. BUYDS supports 
Windows, Linux and Mac OS platforms. 
 
BUYDR is another server application running on a separate machine, it provides close to real-time backup for 
multiple BUYDS. So even if one of the BUYDS failed, the BUYDR still has a copy of the backup data.   
 
The relationships of the Online Backup Suite are depicted in the diagram below. 
 

 
 
^Back to top 
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1.2. The Windows version of BUYDM installer hangs, what could be the 

problem? 

There are few things that could create errors during or after executing the installer. 

1. Make sure there is enough disk space on the machine. 

2. Make sure you do not have any anti virus software or PCanywhere running, as this may create problems 
with InstallAnywhere installers.  

3. There are also problems with InstallAnywhere installers and Dell OpenManager. If OpenManager has 
installed on the target system, be sure to disable it before installing BUYDM. 

4. Hardware could cause errors as well, try set your [hardware acceleration display setting] to off. There are 
problems with certain versions of Java running along with certain video cards. 

5. This may only be a Java problem. 

Also, if you are transferring this file from one machine to another, please be sure the file size is valid and you are 
transferring the file in binary mode. 
 
Java Testing 

Please try running any of the Swing demos that came with the Java runtime in 1.4.X and see if it hangs on Windows. 
In order to fix this problem, some knowledge base on the Internet suggested updating DirectX to at least DirectX 
8.1. Most machines got this problem had DirectX 7.0 installed. (You can use the “dxdiag” command to find out the 
directX version) 

SUN recommended two workarounds for certain video card issues 

1. The following will pass properties to the installer's Virtual Machine: 
In Advanced Designer – Project -> Config -> Additional Arguments 
set that to "-Dsun.java2d.d3d=false -Dsun.java2d.noddraw=true" without the quotes. 

2. Set the following lax property in your LaunchAnywhere for your application's JVM:  
lax.nl.java.option.additional=-Dsun.java2d.d3d=false -Dsun.java2d.noddraw=true 
 
Add the same line to the uninstaller lax file, using a modify file action in your installer in post-install. 

 

^Back to top 

1.3. How does BUYDM detect changes in files? Does it use the Archive bit? 

Some tape backup software resets the Archive bit. Would this affect 

BUYDM when backing up the same data? 

BUYDM compares timestamps of files on the server with the corresponding copies on client machine. Archive bit is 
not used as it does not detect relocated files. Therefore tape backup would not affect BUYDM.  
 
^Back to top 

1.4. Does BUYDM copy the same set of files regularly? 

After the initial upload, subsequent backup jBUYDS will only transfer the modified or new data to the Backup 
server. It depends on the nature of the data, but normally, less than 2% of all data is modified.  
 
^Back to top 

1.5. Transfer Block Size is 128Kb by default. Is there a reason for this? 

Backup data is transferred in blocks (instead of file by file) to minimize connection negotiation roundtrips. It is not 
the TCP/IP block size. This setting is optimal for the backup operation. 
 
^Back to top 
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1.6. How can I backup a huge data set over the Internet? 

If you have a lot of data (e.g. 300GB) to backup to the backup server, it would take a considerable amount of time to 
perform the first full backup over the Internet. You can try the following method:  

1. Use the Seed Loading Utility to backup your backup set to a local hard disk (instead of directly transfer to 
the backup server)  

2. Send the backup data, using a removable hard disk, to your backup service provider.  

3. The administrator can then load all your backup files from your removable hard disk into your backup 
account. This could save you days (even weeks) of performing your first full backup.  

In addition, subsequent backups are incremental (only new or updated files will be uploaded to the server), the 
amount of data transfer should be relatively small.  
 
Please refer to the User’s Guide for details on the “Seed Loading Utility”. 
 

^Back to top 

1.7. What is the best way to restore a huge data set? 

You can copy the data of the particular backup set on BUYDS to a removable media, e.g. external hard disk, and 
ship it to your client. Your client can then use the “Decypt Files Tool” in BUYDM to restore the backup data from 
the removable media to its original format. 
 

^Back to top 

1.8. Does In-File Delta backup require a temporary working directory?  

BUYDM requires a temporary storage for the delta file before it gets sent to the server.  

For example:  

If you have a 10GB file that has already been backed up to the server and you have updated 10MB of this file. 
Then you need to have at least 10MB of free space in the temporary directory for the delta file.  

*Note: Certainly you do not need 10GB of free disk space.  

Also, if you want to backup 5 x 10GB files in the same situation. You will only need 10MB of free space (not 5 x 
10MB), because each delta file will be automatically deleted right after it has been backed up.  

 
^Back to top 

1.9. What is the average compression ratio? 

All backup files are compressed and encrypted before uploading to the Backup Server, the average compression 
ratio for text-based file is around 4:1. However, no further compression can be made on files that are already in 
compressed format (e.g. JPG, ZIP). In general, you can assume a 2:1 compression ratio when you are backing up a 
file set with variety types. 
 
^Back to top 

1.10. Can I change my encrypting key? 

The encrypting key cannot be changed once you setup your Backup Set. This is necessary for the integrity of the 
Backup Set, making sure that backup data is only encrypted by one key. Otherwise, you will have problems 
remember two encrypting keys when you want to restore your files in the future. 
 
You need to recreate your Backup Set if you really want to change your encrypting key.  
 
^Back to top 

1.11. If the “Use Login Password as Encrypting Key” option was selected when 

creating the backup set. Why I cannot restore the backup data with my 
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most current login password? 

By selecting the “User Login Password as Encrypting Key” option when creating a backup set, BUYDM will set 
your login password as the encrypting key for the backup set. Once set, even if you change your login password 
afterward, the encrypting key will remain as your original password. In other words, if you have changed your login 
password, you still need to use the original password to decrypt and restore the backup set. 
 
Currently, if the encrypting key is forgotten or lost, the backup set can never be restored. It is not possible to restore 
without the key. 
 
 
^Back to top 

1.12. What kind of encryption used by BUYDM? 

There are two encryptions being performed by BUYDM: 
 

1. Encryption of backup data - This is being done by 128-bit symmetric key encryption (AES, TripleDES, 
TwoFish). 256-bit is not available because it requires too much CPU and it is not really required. (128-bit 
is currently being used by most banks) 

2. Encryption of backup traffic - This is being done by 1024 bit RSA public key encryption. The strength 
of the encryption depends on the key size you use when you generate your CSR before submitting to your 
CA. 1024 bit is what is being used by most CAs. 

 

^Back to top 

1.13. When select the backup option “local hard drive” to backup to external 

hard drive, it fails in the middle of the process, why? 

Please check if the external hard drive is in FAT32 volume format. And also check whether there is any folder 
containing more than 32000 files and there is no file bigger than 4GB within your backup set. It is a FAT32 
limitation; you may try to convert the FAT32 volume to NTFS.   
 

^Back to top 

1.14. I am having problems with my scheduled backup, why? 

If you are backing up files from a network drive, please check if you have included the valid “Network Resources 
Authentication” information for the backup set. This is required for scheduled backups that access any network 
resources.  

 
^Back to top 

1.15. I cannot get proxy authentication to work with BUYDM, why? 

If you are using port 80, please check whether your proxy server accepts "HTTP CONNECT" calls on port 80. You 
may also want to try other ports like 443 to see if your proxy server accepts that. 
 
^Back to top 

1.16. Can I backup an entire Operating System? 

Currently, it is not possible to do hard disk image backup with BUYDM. However, you can still backup/restore the 
operating system by doing the followings: 
 
To backup all files including the operating system, please do this: 

1. Add all files to your backup source 

2. Add a SystemState backup type to your backup account (Windows only) 
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To restore all files including the operating system, please do this: 

1. Re-install the operating system and applications 

2. Restore the SystemState backup to your machine (Windows only) 

3. Restore all files to your machine 

 

^Back to top 

1.17. When setting up a Microsoft SQL Backup Set, I cannot list the available 

SQL servers, what can I do? 

You can try running “osql –L” in a command prompt, you should see the following: 
 
Servers: 
    (local) 
    SQLSERVER1\INSTANCE1 
    SQLSERVER2\INSTANCE2 
 
If you have a firewall installed, please disable it. UDP Broadcast must be allowed. 
 

^Back to top 

1.18. Why are the Microsoft SQL Server databases missing from the backup 

source list?  

If you have firewall installed on your network, please make sure UDP port 1434 is allowed on the SQL Server.  
 

^Back to top 

1.19. How to set the recovery model of a MS SQL database to FULL? 

You can change the recovery model by running the following commands, run it along with each of the database that 
you want to run transaction log backup. 

C:\> osql -E -S SQLSERVER1\INSTANCE1 -Q "ALTER DATABASE xxx SET RECOVERY FULL" 

    Where 

SQLSERVER1\INSTANCE1 = the SQL Server and the corresponding instance 

xxx = the name of the database 

 
^Back to top 

1.20. Windows network map drive connections are not stable, why? 

You may want to try editing a few Windows Parameters. 
 

SMB Size 

When running applications that copy or move a large amount of data to a remote server, the speed of such action is 
determined by network speed and by the SMB (a protocal related to Windows map drive) size.  

NT/2000 negotiates the SMB size and will generally set this to 4K blocks for applications that are moving or 
copying data to a remote server. By increasing this block size, you will allow the server to complete its file copies 
faster. This will increase the performance of the application making the copy/move calls. 

 

HKEY_LOCAL_MACHINE\System\Current Control Set\Services\LanmanServer\Paramerters 

 

"SizReqBuf"= REG_DWORD 

Set Value To: 16000 = HEXDEC 
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Ref: http://support.microsoft.com/default.aspx?scid=kb;en-us;320829 

     

Map Drive Auto Disconnect Settings 

Reference: http://support.microsoft.com/kb/138365/EN-US/ 

http://support.microsoft.com/default.aspx?scid=kb;en-us;297684  

 

HKEY_LOCAL_MACHINE\System\Current Control Set\Services\LanmanServer\Paramerters 

 

Autodisconnect to: fffffff 

 

Creating BAT file for better performance 

If you are still having problems, you may want setup a BAT file and scheduled this file to run every 10 minutes, 
please setup the BAT file as follow: 

BAT file settings: 
-------------------------- 

ping mapdrv 
ping 192.168.1.15 
net config server /autodisconnect:-1 
net use /persistent:yes 
net use "\\mapdrv\DATA STORAGE1" 
net use "\\192.168.1.15\DATA 
net use d: \\192.168.1.15\DATA STORAGE1 
net use e: "\\mapdrv\DATA STORAGE1" 
dir d:\  
dir e:\  

-------------------------- 

� mapdrv = your NAS device network name 

� 192.168.1.15 = mapdrv 

 
In addition, create a host file on the server hosting the program, have the following entry in it:  
� mapdrv = 192.168.1.15 

 
And if you are on a 2003 server, refer to the following: 

Reference: http://support.microsoft.com/default.aspx?scid=kb;en-us;890553  
 
For Windows 2000, you may want to install the following Hotfix: 
Windows2000-KB903237-x86-ENU 

Reference: http://support.microsoft.com/default.aspx?scid=kb;en-us;903237  
 

^Back to top 

1.21. There is an error when backing up files on a remote NetWare server, what 

can I do? 

If you want to backup \\SERVER\SHARE that is located on a NetWare server and you are getting "Network drive 
is not accessible" error message. Please try adding the following command as a [Pre-backup command]  
 
net use \\SERVER\SHARE [PASSWORD] /USER:[DOMAIN | MACHINE_NAME]\[USERNAME] 
 
This will authenticate the current process with the NetWare server and therefore allow your backup to run correctly. 
 

^Back to top 

1.22. What are the advantages and disadvantages of backing up multiple 

computers using a single backup account?  

Advantages 
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� You require less backup accounts 

� You can use one username and password to configure the backup setting for all Backup Sets 

Disadvantages 

� You must use different backup sets for different computers 

� Whenever a new backup set is created under the backup account, you need to go back to all computers 
using the same backup account to uncheck the “Run scheduled backup on this computer” option for the 
new backup set (Since backup setting is saved on server and new backup set is default to run on all 
computers, i.e. with the option checked). 

� Improper configuration could easily cause problems, which are difficult to debug. 

 
^Back to top 

1.23. Does the BUYDM upgrade the installation of Java on a client machine, or 

does it install a separate copy for its own use?  

BUYDM uses its own copy of Java and leaves the system Java VM intact. 
 

^Back to top 

1.24. After upgrading BUYDS, do I have to upgrade all the BUYDM as well? 

And do I need to transform/migrate their current data? 

BUYDS works with previous versions of BUYDM (However not the other way round). You only need to upgrade 
the existing client software if you want to take advantage of the new features. And you do not need to transfer client 
backup data again after the BUYDS ugprade. 
 
^Back to top 

1.25. Is it possible to do incremental or differential backups with MySQL? 

MySQL backup is done with SQL Dump file, and it generates a single file which is then uploaded. These backup 
files usually very large size and it takes time to backup to the server. At this moment, it is not possible to do 
incremental dump with mysqldump. But our In-File Delta feature shall ensure that, instead of the entire backup file, 
only the changed data blocks within the dump file are uploaded to the Backup Server.  
 
^Back to top 

1.26. How does the “Remove retention files for overlap policy” under Advanced 

Retention Policy work? 

In general, daily snapshots followed by a weekly snapshot or a monthly snapshot, etc. will be removed; weekly 
snapshots followed by a monthly snapshot or a quarterly snapshot, etc. will be removed; and so on.  
 

This is illustrated by the following example. 

Assume today is 17Jan06, and the Advanced Retention Policy is as follows:  

� Daily: retain for 7 days 

� Weekly: retain for 4 weeks (the job will be performed on Saturday) 

� Monthly: retain for 3 months (the job will be performed on 1st of each month) 

If “Remove retention files for overlap policy” is NOT enabled: 

Then a total of 14 snapshots (7+4+3) will be kept on the server accordingly, i.e.:  

(Daily): 10Jan06, 11Jan06, 12Jan06, 13Jan06, 14Jan06, 15Jan06, 16Jan06 
(Weekly): 24Dec05, 31Dec05, 7Jan06, 14Jan06 
(Monthly): 1Nov05, 1Dec05, 1Jan06 

If “Remove retention files for overlap policy” is enabled: 

Then only the following snapshots are kept: 1Nov05, 1Dec05, 1Jan06, 14Jan06, 15Jan06, 16Jan06.  
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Specifically, the weekly policy overrides the daily policy so 10Jan06, 11Jan06, 12Jan06 and 13Jan06 will be 
removed. The monthly policy overrides the weekly policy, and 24Dec05, 31Dec05 and 7Jan06 will be removed as 
well. 
 

^Back to top 

1.27. What is incremental backup and how does In-File Delta work? 

In an incremental backup, only modified files will be uploaded to the Backup Server.  
 
On the other hand, In-File Delta is applicable to the physical files to be uploaded to the Backup Server, does not 
matter whether it is a MS SQL database file, MS Exchange transaction log file or any normal file in a 
FileBackupSet. Specifically, only the changed blocks in comparison to the original file on the Backup Server (delta 
file) will be uploaded. 
 
For each modified file, BUYDM would determine whether the entire file or only delta file should be uploaded. If the 
entire file is to be uploaded, the old version of the file will be moved to the Retention area. Else if only the delta file 
is to be uploaded, the previous delta files will be moved to the Retention area and the Data area should contain the 
original full backup file, checksum file and the latest delta file of this file.  
 
^Back to top 

1.28. How does the “Auto” block size work under In-file Delta settings? 

If the block size is set to “Auto”, the effective block size (Started from BUYDM v5.0.1.7) will be chosen from the 
following table based on the file size of the updated file: 
 
 File Size   Delta Block Size 
 ------------  ---------------- 
 0 - 500M      4k 
 500M - 2G     8k 
 2G - 8G       16k 
 8G - 15G      32k 
 > 15G         64k 
 

^Back to top 

1.29. What happens when we do In-File Delta backup on a directory? 

When you do backup, the Online Backup software will do the followings: 

1. Check if any files are added, updated or deleted (the calculation of these files are based on files having the 
same filename). 

2. New files will be uploaded to the server in whole. 

3. Deleted files will be removed from Data area and placed into the Retention area on the Backup server. 

4. Updated files will be processed by the In-File delta option (i.e. only changed data blocks within the files 
will be uploaded to the Backup Server) 

 
^Back to top 

1.30. Does BUYDM have to stop the application when doing online backups? 

BUYDM can backup application data while the application is still running. Particularly, we have special agents for 
MS Exchange Server, MS SQL Server, Oracle, Lotus Notes and MySQL, which allows these applications to be 
backed up while they are online. With the Volume Shadow Copy feature started from BUYDM v5.0, we are able to 
backup other types of applications while they are online. 
 
^Back to top 
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1.31. What are Off-line backup, Logout backup reminder and Local backup 

features? 

Off-line Backup is basically designed for notebook users who are off-line most of the time, and cannot rely on 
backup schedule to backup regularly. The backup interval allows notebook users to specify the interval that they 
would like their data to backup. If this interval has elapsed, backup will run automatically once this machine is 
online. 
 
Logout Backup Reminder asks user if they would like to backup if they logout of the computer or shutdown their 
computer. 
 
Local Backup allows an extra copy of backup file to be kept on local hard disk when backup is running. 
 
^Back to top 

1.32. Why is my BUYDM running backup once every hour? 

You might have “Off-line backup” enabled for every hour. Please do the following to disable that:  

1. Logon to BUYDM  

2. Select the backup set that you want to disable the Off-line backup from the left panel 

3. Select the [Extra Backup] node under the backup set node on the left panel 

4. Uncheck the [Enable off-line backup] checkbox under the “Off-line Backup” section 

5. If you want to do this to all backup sets, please repeat the previous step for each backup set 

Press the [Save Setting] button from the toolbar 
 

^Back to top 

1.33. How do I disable “logout backup reminder”? 

To disable the “System Logout Backup Reminder”, please do the followings: 

1. Logon to BUYDM  

2. Select the backup set that you want to disable the Logout reminder from the left panel 

3. Select the [Extra Backup] node under the backup set node on the left panel 

4. Uncheck the [Enable System Logout Backup Reminder] checkbox under the “System Logout Backup 
Reminder (Windows)” section 

5. If you want to do this to all backup sets, please repeat the previous step for each backup set 

Press the [Save Setting] button from the toolbar 
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1.34. The MS SQL or MS Exchange database backup job stores 2 copies of the 

spooled database file in the "temporary directory" (tagged with different 

datetimes). This has taken up extra disk space, is this necessary?  

If you have interrupted any of the backup BUYDS, the file tagged with the date time of the corresponding backup 
job will be renamed to its original filename just before it is uploaded. This is necessary as we need to ensure that the 
snapshot of different dates would not overwrite each other. 
 
If a backup job is still running, just let it runs to completion. If backup has been stopped already, just remove all files 
tagged with the corresponding date time in the “temporary directory” and try to perform a full database backup 
again. 
 
^Back to top 
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1.35. What do I have to do in order to backup open files? 

You need to be on BUYDM v5.0 or above, as well as support from the underlying OS. Windows XP and 2003, by 
default, come with Volume Shadow Copy, which allows backup open file. For older platforms, e.g. Windows 
9x/ME/NT/2000 or NetWare, we would recommend adding a third party open file manager option (e.g. St. Bernard 

Open File Manager - http://www.stbernard.com/) which might cost around US$100 for each workstation and 
US$300 for each server if open file backup is required. 
 
*Open file option is not required on Linux/Unix/Mac OS X because no files are held exclusively open by applications. 
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1.36. How does Volume Shadow Copy work? 

Please refer to: 

http://technet2.microsoft.com/WindowsServer/en/Library/2b0d2457-b7d8-42c3-b6c9-
59c145b7765f1033.mspx  
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1.37. In Windows, when BUYDM is creating Shadow Copy Set, it gets the 

“[ERROR] E_UNEXPECTED” error, what can I do? 

This is a Microsoft Volume Shadow Copy issue. Microsoft's recommendation is to try re-registering the Volume 
Shadow Copy Service. If you are on Win XP Pro, you can simply run the batch file available in C:\Program 
Files\BUYDM\bin\RegisterVSS.bat or 

http://download.ahsay.com/support/RegisterVSS.bat.  
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1.38. How to backup Oracle 7.3.4 on NetWare? 

To backup Oracle 7.3.4 on NetWare 5.1, it is not possible to use the Oracle agent, you need to do the followings: 

1. Backup all Oracle 7.3.4 datafiles, control files, and pfile. 

2. Use "exp" (export utility) to dump Oracle database to a dump file (make this a pre-backup command) 

3. Use BUYDM to backup this file 

 
When you need to restore the database, just restore all datafiles, control files, pfile to its original location and use 
"imp" (import utility) to put the data back into Oracle database. 
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1.39. How do I backup NTFS permission? 

For version 5.1 or later, NTFS permission is also backed up during the backup operation. For other versions, please 
do the followings: 

1. Download and install 

http://www.microsoft.com/downloads/details.aspx?FamilyID=E8BA3E56-D8FE-
4A91-93CF-ED6985E3927B&displaylang=en  

2. Add a pre-backup command to dump the NTFS permissions of all files you want to backup into a dump 
file. For example, if you want to have all files under C:\ drive to a C:\NTFS-Permission.txt, please add: 
 
"C:\Program Files\Windows Resource Kits\Tools\subinacl" /noverbose /outputlog=C:\NTFS-
Permission.txt /subdirectories C:\*.* /display 
 
to your pre-backup command. 

3. Add "C:\NTFS-Permission.txt" to the [Backup Source] of this backup set 
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1.40. How do I restore NTFS permission? 

For version 5.1 or later, the backed up NTFS permission will be restored automatically. For other versions, assuming 
the NTFS Permission is being stored in "C:\NTFS-Permission.txt", please do the followings: 

1. Restore "C:\NTFS-Permission.txt" from the backup server using BUYDM 

2. Apply all NTFS permissions backup to all your backup files by running:  
 
"C:\Program Files\Windows Resource Kits\Tools\subinacl" /playfile C:\NTFS-Permission.txt 
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1.41. How do I backup file permission in Linux? 

For version 5.1 or later, Linux file permission is also backed up during the backup operation. For other versions, 
please do the followings: 
 

1. Add a pre-backup command to dump the Access Control Lists of all files you want to backup into a dump 
file. For example, if you want to have all files under /home to a /ACL.txt, please add: 
 
   cd /; getfacl -R home > ACL.txt  
 
to your pre-backup command. 

2. Add "/ACL.txt" to the [Backup Source] of this backup set 
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1.42. How do I restore file permission in Linux? 

For version 5.1 or later, the backed up Linux file permission will be restored automatically. For other versions, 
assuming the Access Control Lists is being stored in "/ACL.txt", please do the followings: 

1. Restore "/ACL.txt" from the backup server using BUYDM 

2. Apply all Access Control Lists backup to all your backup files by running  
 
   cd /; setfacl --restore=ACL.txt 
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1.43. How do I remove BUYDM completely from my Windows machine? 

If you want to completely remove BUYDM from Windows, after uninstalling the software from [Control Panel] -> 
[Add or Remove Programs], please do the followings: 

� Ensure that the BUYDM installation directory is deleted (sometimes not removed when Windows 
somehow holds some of the files) 

� Remove the C:\Documents and Settings\administrator\.BUYDM\ folder (intentionally left undeleted, as 
important information of the user and backup sets, such as the encryption keys, are stored here) 

 

^Back to top 

1.44. Does BUYDM work with dial-up connections? 

It makes no difference to BUYDM if the connection is always on or dial-up.  
 
If you want Windows to connect to the ISP automatically when a backup starts, you can go to [Control Panel] -> 
[Internet Options] -> [Connections] and select “Always dial my default connection”.  
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1.45. The BUYDM crashes when opening [Backup Source] of a Lotus 

Domino/Notes backup set, what can I do? 

Check to see if you can find a hs_err_pid????.log file under the [BUYDM Home], and if it contains the error 
"Unable to complete restart processing, err = Recovery Manager: Error from Logging Subsystem", please do the 
followings: 

1. Go to [Configuration], select [All Server Documents] and choose your corresponding server.  

2. [Disable] Transactional logging at Basics 

3. Go to [Control Panel] -> [Administrative Tools] -> [Services] and restart [Lotus Domain Server] Service 

4. Go to [Configuration] -> select [All Server Documents] and enable Transaction logging 

5. Make sure your logging style is "Archived" 

6. Go to [Services] and restart Lotus Domain Server Service again 
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1.46. How do I restore a machine from my SystemState backup? 

To recovery a machine from scratch, you have to do the followings: 

1. Re-install the operating system 

2. Re-install all applications installed (You can do both of these easily by backing up the system yearly using 
Norton Ghost) 

3. Restore the SystemState backup onto the recovered machine (This will update the recovered system with 
the latest configuration and settings) 

4. Restore all data files onto the recovered system. 

 

^Back to top
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2. Common Error Messages 

2.1. “Internal Error no. 1011” on the BUYDS Management Console 

One license key can only be used to activate a single machine. Have you applied the license key on another machine 
already? Or have you changed your network hardware? Please shutdown the backup service on the first server that 
you have this license key installed. After you have done this, please contact us at 

http://kb.ahsay.com/index.php?_m=tickets&_a=submit&departmentid=3&step=1 and kindly 
provide us with your "License Name" and "License Key", we will update the license server to allow your key to be 
used again. 
 

^Back to top 

2.2.  “Quota Exceeded”  

This means that the backup account has run out of its allocated quota. Please contact your administrator (or backup 
services provider) to increase your backup quota. 
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2.3. “Access is denied”  

This means that the file is not accessible by BUYDM. Please check if the system account that runs BUYDM has 
read access permission to the mentioned file. 
 

^Back to top 
  

2.4. “The process cannot access the file because it is being used by another 

process”  

This means that the file is currently locked by another process (or program). Please shutdown the program locking 

this file before running the online backup program again. You can also refer to “What do I have to do in 
order to backup open files” for more information (for file backup set only). 
 

^Back to top 

2.5. “Premature end of input”  

It means that the client software has problem downloading the list of files to be backed up from the backup server. It 
then retries getting the list again. This is nothing to worry about. BUYDM would log this as information rather than 
warning to avoid raising false alarm. 
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2.6. “Invalid XML Character” / “XML document structures must start and end 

within the same entity” 

Please try the followings: 

1. Logon to the web interface of this backup account 

2. Go to the [File Explorer] page and browse to the directory reported that contain this problem (or some 
other directories) 

3. Check if there are any filenames containing strange characters and delete them 

4. Try backup again. 
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Also, please try increasing the "connectionTimeout" attribute within the "Connector" tag inside [BUYDS 
Home]\conf\server.xml to a larger value (e.g. connectionTimeout="180000" or connectionTimeout="600000"). This 
should help solve the problem. 
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2.7. “Incorrect Function”  

Please check if you have any antivirus or personal firewall software installed. Kindly disable it from scanning the 
related data and traffic to see if the problem persists. 
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2.8. “HTTP/1.1 502 Proxy Error”  

The specified Secure Sockets Layer (SSL) port is not allowed. ISA Server is not configured to allow SSL requests 
from this port. Most Web browsers use port 443 for SSL requests. 

Refer to http://support.microsoft.com/kb/283284  
 

^Back to top 
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2.9. “CExBackup::backupService:HrESEBackupSetup: Error Number 

0xc800020e: An incremental backup cannot be performed when circular 

logging is enabled” 

You need to disable circular logging in MS Exchange. Please uncheck the [Enable circular logging] option as shown 
below and restart the “Microsoft Exchange Information Store” service after you are done. 
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2.10. “CExBackup::backupStorageGroup:HrESEBackupTruncateLogs: Error 



 Securely Backing Up Your Data 

 
Back Up Your Data 

Technical FAQ 

 

 

 

Number 0xc7ff1004: (null)” 

This is an error returned by the Microsoft API and is a Microsoft issue. Please try to restart the "Microsoft Exchange 
Information Store” service. If the problem persists, you may want to schedule the service to restart on a daily basis. 
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2.11. “CExBackup::backupStorageGroupLog:HrESEBackupGetLogAndPatchFi

les: Error Number 0xc8000232: Some log or patch files are missing” 

If you have just disabled the MS Exchange circular logging option, please try running a full backup again, this 
should fix the problem. 
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2.12. “CExBackup::backupFile:WriteFile: Error Number 0x6: The handle is 

invalid”  

This is the MS Exchange having problem in writing to the Temporary spooling directory. Please ensure that the 
system account running the MS Exchange has full access right to that directory. If it is a network drive, please use an 

UNC path (e.g. \\server\share), and the “Network Resources Authentication for Windows” is properly set for the 
corresponding backup set. 
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2.13. “Path ‘C:\Temp\MSSQLServer\1137040769567’ does not exist” 

If you get this error while you are doing MS SQL or MS Exchange backup, please try to use an UNC path (e.g. 
//server/share) in "Temporary directory for storing backup files" under [Backup Source Settings]. Please make sure 
that your BUYDM is on the same machine as your MS SQL or MS Exchange. Please also ensure that you have 
included the appropriate “Network Resources Authentication for Windows” information in the backup set. 

 
For MS SQL Server, you may want to check whether if it can spool the database file correctly by running the 
following command: 
 
(Windows Authentication mode) 
osql -E -Q "DECLARE @dbname char(64) SET @dbname = 'xxx' BACKUP DATABASE @dbname TO DISK = 
'//server/share/abc.txt' WITH SKIP" 
 

OR 
 
(SQL Server Authentication mode) 
osql -U USERNAME -P PASSWORD -Q "DECLARE @dbname char(64) SET @dbname = 'xxx' BACKUP 
DATABASE @dbname TO DISK = '//server/share/abc.txt' WITH SKIP" 
 
Note:  

USERNAME/PASSWORD = the database username/password 
xxx = the database that you would like to backup 
//server/share/abc.txt = the location for the database spooling file 
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*** End of FAQ *** 

 


